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Abstract

BibleTime is a completely free Bible study program. The program's user interface is built with the Qt framework,
which makes it run on several operating systems including Linux, Windows, FreeBSD and Mac OS X. The software
uses the SWORD programming library to work with over 900 free Bible texts, commentaries, dictionaries and books
in over 50 languages provided by the Crosswire Biblijos Draugija and several other repositories.

BibleTime Žinynas yra platinamas kartu su BibleTime studijavimo programa.
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Chapter 1. #žanga
Apie BibleTime

BibleTime yra Biblijos studijavimo #rankis, palaikantis #vairius teksto tipus ir kalbas. Netgi didelius
veikl# moduli# kiekius yra lengva #diegti ir tvarkyti. Programa yra sukurta SWORD [http://
www.crosswire.org/sword/] bibliotekos pagrindu. Ši biblioteka suteikia vidin#s BibleTime pus#s
funkcionalum#, tok# kaip Biblijos tekst# rodym#, paiešk# ir t. t. SWORD yra Crosswire Biblijos Draugija
[http://www.crosswire.org] geriausias parodomasis produktas.

BibleTime yra sukurta naudoti su veiklomis, užkoduotomis vienu iš SWORD projekto palaikom# format#.
Vis# informacij# apie palaikomus dokument# formatus galite rasti Crosswire Biblijos Draugija SWORD
projekto  k#r#j# sekcijoje [http://www.crosswire.org/sword/develop/index.jsp].

Prieinamos veiklos
Over 280 documents in 50 languages are available from the Crosswire Biblijos Draugija [http://
www.crosswire.org]. These include:

Biblijos Pilni Biblijos tekstai su pasirinktinais, tekste
esan#iais dalykais, tokiais kaip Strongo numeriai,
antrašt#s ir/ar porašt#s. Biblijos yra prieinamos
daugeliu kalb#, jose yra ne tik šiuolaikin#s versijos,
bet taip pat ir senoviniai tekstai, tokie kaip Codex
Leningradensis ("WLC", Hebraj#), ir Septuagint
("LXX", Graik#). Tai yra labiausiai išpl#sta SWORD
projekto bibliotekos sekcija.

Knygos Books available include "Imitation of Christ",
"Enuma Elish", and "Josephus: The Complete
Works"

Komentarai Commentaries available include classics like
John Wesley's "Notes on the Bible", Matthew
Henry's commentary and Luther's "Commentary on
Galatians." With the Personal commentary you can
record your own personal notes to sections of the
Bible.

Kadieniai pašventimai Many people appreciate these daily portions from
God's word. Available works include Daily Light on
the Daily Path, and the Losungen.

Leksikonai/Žodynai Lexicons available include: Robinson's
Morphological Analysis Codes, and the International
Standard Bible Encyclopaedia. Dictionaries
available include Strong's Hebrew Bible Dictionary,
Strong's Greek Bible Dictionary, Webster's Revised
Unabridged Dictionary of the English Language
1913, Nave's Topical Bible.

There are several other repositories that BibleTime will load and use.
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#žanga

Motyvacija
M#s# noras yra tarnauti Dievui ir padaryti savo dal#, padedant kitiems augti santykiuose su Juo. Mes
siek#me ši# program# padaryti galing#, kokybišk#, bet tuo pa#iu metu ir lengvai bei intuityviai naudojam#.
Mes nor#tume, kad b#t# pašlovintas Dievas, kadangi Jis yra vis# ger# dalyk# šaltinis.

Kiekvienas geras davinys ir tobula dovana ateina iš aukštybi#, nužengia nuo šviesybi#
T#vo, kuriame n#ra joki# atmain# ir joki# sambr#šk#.

—Jok#bo 1,17, Biblija RK_K1998

Telaimina jus Dievas, besinaudojant šia programa.
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Chapter 2. BibleTime paleidimas
Kaip paleisti BibleTime

BibleTime paleidimas
BibleTime yra vykdomasis failas, kuris yra integruotas su j#s# darbalaukiu. Galite paleisti BibleTime iš
Pradžios meniu, naudodamiesi šia piktograma:

BibleTime taip pat gali b#ti paleista iš terminalo komand# eilut#s. Kad paleistum#te BibleTime, atverkite
terminalo lang# ir #rašykite:

bibletime

Paleisties tinkinimas
Terminale, galite naudoti BibleTime, kad numatytoje Biblijoje atvertum#te atsitiktin# eilut#:

bibletime --open-default-bible "<random>"

Kad atvertum#te nurodytoje vietoje, tokioje kaip Jono 3:16, naudokite:

bibletime --open-default-bible "Jono 3:16"

Galite taip pat naudoti knyg# pavadinimus savo esamos kalbos knyg# pavadinim# kalba.

Pirmasis BibleTime paleidimas
Jeigu BibleTime paleidžiate pirm#j# kart#, tikriausiai, nor#site sukonfig#ruoti Nustatym# meniu juostoje
prieinamas sekan#ias parinktis.

Knyg# lentynos tvarkytuv# Modifies your Bookshelf. This dialog lets
you modify your Bookshelf, add or delete
works from your system. It will only be
shown if no default Bookshelf can be found.
Please see The Bookshelf Manager section
for further details. If you start off with an
empty Bookshelf, it will be helpful to install
at least one Bible, Commentary, Lexicon
and one Book to get to know BibleTime's
basic features quickly. You will be presented
with a list of works that are available from
the Crosswire Biblijos Draugija and other
repositories;

BibleTime konfig#ravimo dialogas Individualizuoja BibleTime. Šis dialogas
leidžia jums pritaikyti BibleTime savo
reikm#ms. Prašome ži#r#ti išsamesn# šio
dialogo apraš#.
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Chapter 3. Programos darbas
Programos apžvalga

This is what a typical BibleTime session looks like:

You can easily see the different parts of the application. The top left window is used to open installed
works in the Bookshelf tab, and with the Bookmarks tab you can manage your bookmarks. The little "Mag"
window below the Bookshelf is used to display extra information that is embedded in documents. When
you move your mouse over a footnote marker, for example, then the Mag will display the actual content
of the footnote. The toolbar gives you quick access to important functions, and the Desk on the right side
is where you do your real work.

Dabar t#skime ir atskirai apžvelkime #vairias programos dalis.

BibleTime programos lango dalys

Knyg# lentyna
The Bookshelf lists all installed works, sorted by category and language. It also has a category called
"Bookmarks". This is where you can store and access your own bookmarks.

Opening works

To open a work from the bookshelf for reading, simply double-click with the left mouse button on
the desired category (Bibles, Commentaries, Lexicons, Books, Devotionals or Glossaries) to display its
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Programos darbas

contents. Then just double-click on one of the works to open it for reading. A read window will appear
in the Desk area.

If you are reading a certain work, and want to open another work at the passage you are reading, you can
use a shortcut. Simply click with the left mouse button on the verse/passage reference (pointer changes
to hand) and drag it to the Bookshelf. Drop it on the work you want to open, and it will be opened for
reading at the specified location. You can also drag a verse reference into an existing read window, then
it will jump to the specified location.

Papildoma informacija apie veiklas

If you click with the right mouse button on the symbol of a work, you will see a menu with additional entries
that are relevant for this work. "About this work" opens a window with lots of interesting information
about the selected work. "Unlock this work" opens a small dialog for encrypted documents, where you
can enter the unlock key to access the work. For additional information on locked works, please see
the  Locked Modules [http://www.crosswire.org/sword/modules/aboutlocked.jsp] page on the Crosswire
Biblijos Draugija web site.

Paieška veiklose

You can search in a work by clicking with the right mouse button on its symbol and selecting "Search in
work(s)". By pressing Shift and clicking on other works you can select more than one. Then follow the
same procedure to open the search dialog. You will be searching in all of these documents. A complete
description of the operation of the search features can be found on the Searching in Works section.

Darbas su adresynu

Tip

Drag & Drop Works Here
Click with the right mouse button on the bookmark category of the bookshelf and select "Create new folder"
to create a new bookmark subfolder. You can use normal drag & drop functions to drag verse references
from read windows or search results to the bookmark folder, and to rearrange bookmarks between folders.

You can also import bookmarks from other people or export bookmarks to share them. To do this, open the
context menu of the bookmark folder as described above, and select "Export bookmarks". This will bring
up a dialog box for you to save the bookmark collection. You can import bookmarks in a similar way.

You can also click with the right on folders and bookmarks to change their names and descriptions.

Perži#ros langelis
This little window in the lower left corner of the BibleTime window is purely passive. Whenever your
mouse cursor is located over some text with additional information (e.g., Strong's numbers), then this
additional information will be displayed in the Mag, and not in the text itself. Just try it out.

Stalas
The Desk is where the real work with BibleTime takes place. Here you can open works from the Bookshelf,
read them, search in them, and even save your annotations in the personal commentary module (see below).

Veikl# skaitymas

As we have already seen, you can open works for reading simply by clicking on their symbol in the
Bookshelf. A read window will open in the Desk's area. Every read window has a toolbar. There you can
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Programos darbas

find tools to navigate in the work that this read window is connected to, as well as history buttons like the
ones that you know from your browser.

Auto Scrolling

The currently active window can be auto scrolled up or down. Start scrolling by press Shift+Down. You
can increase the scrolling speed by pressing Shift+Down multiple times. To pause scrolling press Space.
To start scrolling again at the previous speed press Space again. To slow down scrolling or scroll the other
direction press Shift+Up one or more times. Pressing any other key or changing the active window will
stop the scrolling.

Skaitymo lango vieta

Of course, you can open multiple works at the same time. There are several possibilities for arranging the
read windows on the desk. Please have a look at the entry Window in the main menu. There you can see
that you can either control the placement of the read windows completely yourself, or have BibleTime
handle the placement automatically. To achieve this, you have to select one of the automatic placement
modes available at Window → Arrangement mode. Just try it out, it's simple and works.

J#s# asmenini# komentar# redagavimas

To be able to store your own comments about parts of the Bible, you have install a certain work from
the library of the Crosswire Biblijos Draugija [http://www.crosswire.org]. This work is called "Personal
commentary".

Open the personal commentary by clicking on its symbol in the Bookshelf with a left mouse button. You
can edit this commentary by just clicking on any verse. A dialog opens which allows you to add or edit
text for that verse.

Tip

If Edit this work is deactivated, please check if you have write permission for the files of the
personal commentary.

Tip

Drag & drop works here. Drop a verse reference and the text of the verse will be inserted.

Paieška veiklose

Paieška atverto skaitymo lango tekste
You can look for a word or phrase in the open read window (e.g. the chapter of a bible that you're reading)
just like you are used to from other programs. This function can be reached either by clicking with the
right mouse button and selecting Find..., or by using the shortcut CtrlF. Read on to learn how you can
search in entire works.

Prieiga prie paieškos dialogo
You can search in a work by clicking with the right mouse button on its symbol in the Bookshelf and
selecting Search in work(s). By holding Shift or Ctrl and clicking on other work's names you can select
more than one. Then follow the same procedure to open the search dialog. You will be searching in all
of these works at the same time.
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Programos darbas

You can also access the search dialog by clicking on Search from the main menu, and selecting the
appropriate entry.

A third possibility to start searches is to click on the search symbol in an open read window.

Paieškos konfig#racija

Veikl# pasirinkimas

At the top of the options tab you will find Choose(works). If you would like to search in multiple works,
click on this button and you will be offered a menu where you can select the works you want to search in.

Paieškos r#ži# naudojimas

You can narrow the scope of your search to certain parts of the Bible by selecting one of the predefined
scopes from the list in Search scope. You can define your own search ranges by clicking the Setup ranges
button.

Pagrindin#s paieškos sintaks#s pristatymas

Enter the search phrase separated by spaces. By default the search function will return results that match
all the words. If you want to find any of the words entered, select the Some words button. If you want
to perform a more complex search, select the Free button. You can see examples of searches by clicking
on full syntax.
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Programos darbas

You can use wildcards: '*' matches any number of characters, while '?' will match any single character.
The use of parenthesis allows you to group your search terms, e.g. '(Jesus OR spirit) AND God'.

To search text other than the main text, enter the text type followed by ':', and then the search term. Refer
to the table below for examples.

Available text types:

Table 3.1. Paieškos tipai

Priešd#lis Reikšm# Pavyzdys

heading: ieško antrašt#se heading:J#zus

footnote: ieško išnašose footnote:Moses

strong: ieško Strongo numeriuose strong:G535

morph: ieško morfologiniuose koduose morph:N-GSM

Tip

You can right click on an installed work and select About to find which of the above search criteria
may work for you. Not all works have the built in features for performing this type of search.

BibleTime j#s# paieškoms atlikti naudoja Lucene paieškos modul#. Jame yra daug išpl#stini#
ypatybi#, o daugiau apie j# galite perskaityti #ia:  http://lucene.apache.org/java/docs/index.html [http://
lucene.apache.org/java/docs/index.html].

Paieškos rezultatai
Here you can see how many instances of the search string were found, sorted by works. Clicking on a
work with the right mouse button allows you to copy, save, or print all verses that were found in a certain
work at once. This also works when you click on one or more of the references to copy, save or print them.
Clicking on a particular reference opens that verse up in context in the preview window below.

Tip

Drag a reference and drop it on a work symbol on the Bookshelf to open the work at that verse
in a new read window.

Tip

Drag a reference and drop it on an open read window, and it will jump to that verse.

Tip

Select references and drag them to the Bookshelf to create bookmarks.

Paieškos rezultat# analiz#

Click on Search analysis to open the search analysis display. This gives a simple graphic analysis of the
number of instances the search string was found in each book of the Bible, and you can also save the
analysis.
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Programos darbas

Knyg# lentynos tvarkytuv#
The Bookshelf Manager is a tool to manage your Bookshelf. You can install new works to your Bookshelf,
and update or remove existing works from your Bookshelf. Access it by clicking Settings → Bookshelf
Manager in the main menu.

Install works

With this facility, you can connect to a repository of works (called "library"), and transfer one or more
works to your local Bookshelf. These libraries may be local (e.g. a SWORD CD), or remote (e.g.
Crosswire's online repository of SWORD modules, or another site offering SWORD modules). BibleTime
will automatically maintain a list of remote libraries and the works available from them.

To begin the installation process, select one or more libraries that you want to install works from. Then
click on the Next button. Then select one or more languages and click the Next button. You will see a list
of categories. Double-click on a category to see works for that category. Select one or more works and
then click on the Install Works. After the works are installed, click on the Finish.

Update works

If there are any works that can be updated, they will be shown. Select one or more work and click the
Update Works. After the works are updated, click on the Finish.

Remove works

This facility allows you to delete one or more of the works from your Bookshelf too free up disk space.
Simply choose the works` and click on the Remove works button.
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Programos darbas

Eksportavimas ir spausdinimas
In many places, you can open a context menu by clicking with the right mouse button. Depending on
context, it will allow you to Select, Copy (to clipboard), Save or Print text. This works for example in the
read windows, when you click on the normal text or the verse reference, or in the search result page when
you click on a work or one or more verse references. It is pretty straightforward, so just try it out.

Printing from BibleTime is rather basic and is intended as a utility. If you are composing a document or
presentation containing text from BibleTime works, we suggest that you use one of the presentation or
editing tools on your system to format your document, rather than printing from BibleTime directly.
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Chapter 4. BibleTime konfig#ravimas
Šioje sekcijoje j#s rasite BibleTime konfig#ravimo apžvalg#, kuri# galima rasti pagrindinio meniu punkte
Nustatymai

BibleTime konfig#ravimo dialogo langas
BibleTime naudotojo s#saja, priklausomai nuo j#s# poreiki#, gali b#ti tinkinama #vairiais b#dais. J#s
galite pasiekti konfig#ravimo dialogo lang#, pasirinkdami Nustatymai Konfig#ruoti BibleTime.

Rodymas

Paleisties elgsena gali b#ti tinkinama. Pasirinkite iš sekan#i# parink#i#:

• Rodyti prisistatymo logotip#

Rodymo šablonai, apibr#žia teksto atvaizdavim# (spalvas, dyd# ir t. t.). Yra prieinami #vair#s #taisyti
šablonai. Pasirink# vien# iš šablon#, dešiniame polangyje matysite perži#r#.

Stalas

Daugelis, SWORD vidin#s pus#s pateikiam#, ypatybi#, dabar, gali b#ti tinkinamos programoje
BibleTime. Šios ypatyb#s yra dokumentuotos tiesiai dialoge. J#s taip pat turite galimyb# apibr#žti
standartines veiklas, kurios tur#t# b#ti naudojamos, kai nuorodoje n#ra apibr#žta jokia specifin# veikla.
Pavyzdys: Standartin# Biblija yra naudojama Biblijos kryžmini# nuorod# turinio rodymui. Kai ant j#
užvedate pel#, Perži#ros langelis rodys nurodom# eilu#i# turin#, atitinkamai j#s# nurodytos standartin#s
Biblijos. Naudodami teksto filtrus, galite valdyti teksto išvaizd#.

Kalbos

#ia galite nurodyti, kokia kalba tur#t# b#ti rodomi Biblijos knyg# pavadinimai. Nusistatykite ši# parinkt#
# savo gimt#j# kalb#, jei ji prieinama, ir jausit#s kaip namie.

Pagal numatym#, BibleTime naudoja numatyt#j# sistemos šrift#. Jei b#tina, galite nustelbti š# šrift#. Kai
kurios kalbos tam, kad b#t# teisingai rodomos, reikalauja ypating# šrift# ir šis dialogo langas kiekvienai
kalbai leidžia jums nurodyti pasirinktin# šrift#.
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BibleTime konfig#ravimas

Parink#i# langas - Šriftai.

Dabar BibleTime gali naudoti visus palaikomus šriftus. Tol, kol jus dominan#ios veiklos yra rodomos
teisingai, #ia nieko nereikia daryti. Jei veikla rodo tik eil# klaustuk# (??????) arba tuš#ias d#žutes, žinokite,
kad standartiniame rodymo šrifte n#ra šioje veikloje naudojam# simboli#.

Nor#dami tai ištaisyti, iš išskleidžiamojo meniu pasirinkite šios veiklos kalb#. Pažym#kite žymim# langel#
"Naudoti tinkint# šrift#". Pavyzdžiui, daugel# kalb# palaikantis šriftas yra Code2000. Jei n# vienas
#diegtas šriftas nerodo jus dominan#ios veiklos, pabandykite #diegti tos kalbos lokalizavimo paket#.

Šrift# diegimas

Išsamesni šrift# diegimo nurodymai yra už šio žinyno rib#. Tolimesnei informacijai, galb#t, nor#tum#te
kreiptis #  Unicode INSTRUKCIJ# [http://www.linux.org/docs/ldp/howto/Unicode-HOWTO-2.html].

Šriftai gali b#ti #diegti iš daugelio šaltini#:

• J#s# *nix distribucijos.

• J#s# distribucijos lokalizacijos paket#.

• Tame pa#iame kompiuteryje esan#ios Microsoft Windows® sistemos diegimo.

• Šrift# kolekcij#, toki# kaip yra prieinamos iš Adobe ar Bitstream.

• Žiniatinklio šrift# kolekcij#.
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BibleTime konfig#ravimas

Unicode šriftai palaiko daugiau simboli# nei kiti šriftai, be to, kai kurie iš j# yra prieinami be jokio
mokes#io. Nei viename iš prieinam# šrift# n#ra vis#, Unicode standartu, apibr#žt# simboli#, tod#l, galb#t,
pageidausite skirtingoms kalboms naudoti skirtingus šriftus.

Table 4.1. Unicode šriftai

Code2000 [http://code2000.net/CODE2000.ZIP] Ko gero, geriausias nemokamas Unicode šriftas,
apimantis didel# simboli# skai#i#.

SIL unicode šriftai [http://scripts.sil.org/cms/
scripts/page.php?
site_id=nrsi&cat_id=FontDownloads]

Puik#s Unicode šriftai iš Summer Institute of
Linguistics

FreeFont [http://www.nongnu.org/freefont/] Nauja nemokama Unicode šrift# iniciatyva.

Crosswire šrift# katalogas [ftp://ftp.crosswire.org/
pub/sword/iso/latest/FONTS/]

Keli šriftai prieinami iš Crosswire Biblijos Draugija
FTP svetain#s.

Bitstream CyberBit [http://aol-4.vo.llnwd.net/pub/
communicator/extras/fonts/windows/]

Apima beveik vis# Unicode, ta#iau, d#l savo
dydžio, gali sul#tinti BibleTime programos darb#.

Clearlyu #trauktas # kai kurias distribucijas. Sudarytas iš
Europos, Graik#, Hebraj#, Taj#.

Caslon, Monospace, Cupola, Caliban [http://
fontforge.sourceforge.net/sfds/]

Dalinis simboli# palaikymas, ži#r#kite informacij#
nurodytoje svetain#je.

There are good Unicode font lists on the net, as the one by Christoph Singer ( Multilingual Unicode
TrueType Fonts in the Internet [http://www.slovo.info/unifonts.htm]), or the one by Alan Wood (
Unicode character ranges and the Unicode fonts that support them [http://www.alanwood.net/unicode/
fontsbyrange.html]).

Spartieji klavišai

Shortcuts (previously known as HotKeys) are special key commands that can be used in the place of the
menu items and icons. A number of BibleTime's commands have predefined Shortcuts (see the Shortcuts
section for a complete listing). Most of BibleTime's commands can be assigned Shortcuts. This is very
helpful to quickly access the functions that you need the most.

13

http://code2000.net/CODE2000.ZIP
http://code2000.net/CODE2000.ZIP
http://scripts.sil.org/cms/scripts/page.php?site_id=nrsi&cat_id=FontDownloads
http://scripts.sil.org/cms/scripts/page.php?site_id=nrsi&cat_id=FontDownloads
http://scripts.sil.org/cms/scripts/page.php?site_id=nrsi&cat_id=FontDownloads
http://scripts.sil.org/cms/scripts/page.php?site_id=nrsi&cat_id=FontDownloads
http://www.nongnu.org/freefont/
http://www.nongnu.org/freefont/
ftp://ftp.crosswire.org/pub/sword/iso/latest/FONTS/
ftp://ftp.crosswire.org/pub/sword/iso/latest/FONTS/
ftp://ftp.crosswire.org/pub/sword/iso/latest/FONTS/
http://aol-4.vo.llnwd.net/pub/communicator/extras/fonts/windows/
http://aol-4.vo.llnwd.net/pub/communicator/extras/fonts/windows/
http://aol-4.vo.llnwd.net/pub/communicator/extras/fonts/windows/
http://fontforge.sourceforge.net/sfds/
http://fontforge.sourceforge.net/sfds/
http://fontforge.sourceforge.net/sfds/
http://www.slovo.info/unifonts.htm
http://www.slovo.info/unifonts.htm
http://www.slovo.info/unifonts.htm
http://www.alanwood.net/unicode/fontsbyrange.html
http://www.alanwood.net/unicode/fontsbyrange.html
http://www.alanwood.net/unicode/fontsbyrange.html


BibleTime konfig#ravimas

In the preceding example, F2, Bible Study HowTo has a secondary shortcut defined, CTRL+2.
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Chapter 5. Nuoroda
Pagrindinio meniu nuorodos

In this section you can find detailed descriptions of all entries in the main menu of BibleTime. They are
ordered in just the way they appear in BibleTime, with all the sub-items listed under the major menu item
they belong to. You can also see the shortcut of each item;a complete listing of all shortcuts can be found
in the shortcuts section.

Failas

Failas 

→

 Atverti veikl#

Atverti veikl#. Tai jums parodys meniu,
kuriame leidžiama atverti #diegtas knygas.

Failas 

→

 Baigti (Ctrl+Q)

Užveria BibleTime. BibleTime j#s# paklaus
ar norite # disk# #rašyti neišsaugotus
pakeitimus.

Rodinys

Rodinys 

→

 Viso ekrano veiksena (F5)

Perjungia viso ekrano rodym#. Perjunkite
š# nustatym#, kad išdidintum#te BibleTime
lang#.

Rodinys 

→

 Rodyti knyg# lentyn#

Perjungia Knyg# lentynos rodym#.
Perjunkite š# nustatym#, kad išjungtum#te ar
#jungtum#te, kairiajame polangyje esan#i#,
Knyg# lentyn#. Tai gali praversti, jeigu
Perži#ros langeliui reikia daugiau vietos.

Rodinys 

→

 Rodyti adresyn#

Perjungia Adresyno rodym#. Perjunkite š#
nustatym#, kad išjungtum#te ar #jungtum#te,
kairiajame polangyje esant#, Adresyn#. Tai
gali praversti, jeigu Perži#ros langeliui reikia
daugiau vietos.

Rodinys 

→

 Rodyti perži#ros langel#

Perjungia Perži#ros langelio rodym#.
Perjunkite š# nustatym#, kad išjungtum#te
ar #jungtum#te, kairiajame polangyje esant#,
Perži#ros langel#.

Rodinys 

→

 Rodyti lygiagretaus teksto antraštes

Perjungia papildom# veikl# rodym# Šio
nustatymo perjungimas, leidžia jums matyti
papildomas veiklas lygiagre#iai su j#s#
esamomis atvertomis veiklomis.

Rodinys → #ranki# juostos → Rodyti pagrindin#
#ranki# juost# (F6)

Perjungia Pagrindin#s #ranki# juostos
rodym#. Perjunkite š# nustatym#, kad
išjungtum#te ar #jungtum#te pagrindin#
#ranki# juost#.

Rodinys → #ranki# juostos → Rodyti naršymo juost# Perjungia veiklose naršym#. Perjunkite š#
nustatym#, kad veiklose prid#tum#te ar
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pašalintum#te Naršymo jungtin# langel#. Tai
gali praversti, norint atvertose veiklose matyti
vis# #ranki# juost#.

Rodinys → #ranki# juostos → Rodyti veikl# #ranki#
juost#

Perjungia veiklose #ranki# juostas.
Perjunkite š# nustatym#, kad atvertose
veiklose prid#tum#te ar pašalintum#te veikl#
piktogramas.

Rodinys → #ranki# juostos → Rodyti #ranki# #ranki#
juost#

Perjungia veiklose #rankius. Perjunkite
š# nustatym#, kad atvertose veiklose
prid#tum#te ar pašalintum#te #ranki#
piktogramas.

Rodinys → #ranki# juostos → Rodyti formatavimo
#ranki# juost#

Perjungia formatavim#. Perjunkite š#
nustatym#, Asmeniniuose Komentaruose
redaguodami HTML. Jis prid#s arba pašalins
formatavimo #ranki# juost#.

Rodinys → #ranki# juostos → Rodyti #ranki# juostas
tekstiniuose languose

Perjungia veiklose #ranki# juostas.
Perjunkite š# nustatym#, kad atvertose
veiklose prid#tum#te ar pašalintum#te piln#
#ranki# juost#.

Paieška

Paieška 

→

 Ieškoti standartin#je Biblijoje (Ctrl
+Alt+F)

Atveria paieškos dialog#, skirt# ieškoti
tik standartin#je Biblijoje. Paieškos dialoge
gali b#ti prid#ta daugiau veikl#. Išsamesn#
paieškos apraš# galite rasti skyriuje Paieška
veiklose.

Paieška 

→

 Ieškoti atvertose veiklose (Ctrl+O)

Atveria paieškos dialog#, skirt# paieškai
visose veiklose. Paieškos dialoge veiklos gali
b#ti pridedamos arba šalinamos. Išsamesn#
paieškos apraš# galite rasti skyriuje Paieška
veiklose.

Langas

Langas 

→

 Užverti lang# (Ctrl+W)

Užveria aktyv# lang#.

Langas 

→

 Užverti visus langus (Ctrl+Alt+W)

Užveria visus atvertus langus.

Langas 

→

 Išd#styti pakopomis (Ctrl+J)

Išd#sto pakopomis visus atvertus langus.

Langas 

→

 Išloti (Ctrl+I)

Iškloja visus atvertus langus.
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Langas 

→

 Iškloti vertikaliai (Ctrl+G)

Automatiškai vertikaliai iškloja visus atvertus
langus.

Langas 

→

 Iškloti horizontaliai (Ctrl+H)

Automatiškai horizontaliai iškloja visus
atvertus langus.

Langas → Išd#stymo veiksena Controls the basic window arrangement
behaviour. In the opening context menu, you
can either specify that you want to take care
of the window arrangement yourself (Manual
mode), Tabbed, Auto-tile vertically, Auto-tile
horizontally, Auto-tile or Auto-cascade. Just
try them out!

Window → Save session Directly saves the current session. This will
open a context menu where you can select
an existing session to save to. It will be
overwritten with your current session. See the
next item on how to save to a new session.

Langas → Išsaugoti kaip nauj# sesij# (Ctrl+Alt+S) Išsaugo esam# sesij# nauju pavadinimu.
Tai paklaus naujo išsaugomos sesijos
pavadinimo.

Langas → #kelti sesij# #kelia esam# sesij#. Tai atveria kontekstin#
meniu, kuriame galite pasirinkti norim#
#kelti esam# sesij#.

Langas → Ištrinti sesij# Ištrina esam# sesij#. Tai atveria kontekstin#
meniu, kuriame galite pasirinkti, kuri esama
sesija tur#t# b#ti ištrinta.

Nustatymai

Nustatymai 

→

 Konfig#ruoti BibleTime

Atveria BibleTime's pagrindin#
konfig#racijos dialog#. Jame galite
konfig#ruoti visokius #domius nustatymus,
kad pritaikytum#te BibleTime savo
poreikiams. Išsamesnei informacijai,
prašome ži#r#ti BibleTime konfig#ravimo
sekcij#.

Nustatymai 

→

 Knyg# lentynos Tvarkytuv# (F4)

Atveria dialog#, kuriame galite keisti savo
SWORD konfig#racij# ir tvarkyti savo knyg#
lentyn#. Išsamesnei informacijai, prašome
ži#r#ti Knyg# lentynos tvarkytuv#s sekcij#.

Pagalba

Pagalba 

→

 Žinynas (F1)

Atveria BibleTime's žinyn# J#s šiuo metu j#
skaitote.
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Pagalba 

→

 Biblijos studijavimo instrukcija (F2)

Opens a guide on how to study the Bible It
is the hope of the BibleTime team that this
HowTo will provoke the readers to study the
scriptures to see what they say. This particular
study guide has been chosen as it takes care
not to advocate any particular denominational
doctrine. We expect you to read and study the
scriptures to understand what they say. If you
start with the attitude that you want to have
the Lord sow his word in your heart He will
not disappoint you.

Pagalba 

→

 Dienos patarimas... (F3)

Atveria nauding# patarim# Dienos patarimas
suteikia nauding# patarim#, kuris pagelb#s
naudojantis BibleTime programa.

Pagalba → Apie BibleTime Atveria lang#, kuriame pateikiama
informacija apie BibleTime projekt# kartu
su informacija apie BibleTime programin#s
#rangos versij#, projekto talkininkus,
SWORD programin#s #rangos versij#, Qt
programin#s #rangos versij# ir licencijos
sutikim#.

Veikl# rodykl#
Šioje sekcijoje galite rasti, su atvertomis veiklomis susijusi# piktogram#, aprašus.

Slenka pirmyn per istorij#.

Slenka atgal per istorij#.

Pasirinkti #diegt# Biblij#.

Pasirinkti papildom# Biblij#.

Ieškoti pasirinktose veiklose.

Rodyti konfig#racij#.

Pasirinkti #diegtus komentarus.
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Pasirinkti papildomus komentarus.

Sinchronizuoti rodom# #raš# su aktyviu
Biblijos langu.

Pasirinkti knyg#.

Pasirinkti #diegt# aiškinam#j# žodyn# ar
pašventim#.

Pasirinkti papildom# aiškinam#j# žodyn# ar
pašventim#.

Spar#i#j# klaviš# indeksas
This is an index of all shortcuts and their corresponding description in the handbook. The shortcuts are
sorted (roughly) alphabetical. If you want to directly find out which shortcuts a certain menu item has,
you can either look at the entry itself in BibleTime (as it always shows the shortcut), or you can look it
in the Main Menu reference.

Spartieji klavišai Aprašas

Alt+Kair#n Moves back in the history of read windows.

Alt+Dešin#n Moves forward in the history of read windows.

Ctrl+Alt+F Paieška → Ieškoti standartin#je Biblijoje
ekvivalentas; atveria paieškos dialog#, skirt# atlikti
paiešk# numatytoje Biblijoje.

Ctrl+Alt+G Langas → Išd#stymo veiksena → Automatiškai
iškloti vertikaliai ekvivalentas; perjungti
automatin# lang# išklojim#.

Ctrl+Alt+H Langas → Išd#stymo veiksena → Automatiškai
iškloti horizontaliai ekvivalentas; perjungti
automatin# lang# išklojim#.

Ctrl+Alt+I Langas → Išd#stymo veiksena → Automatiškai
iškloti ekvivalentas; perjungti automatin# lang#
išklojim#.

Ctrl+Alt+J Langas → Išd#stymo veiksena → Automatiškai
iškloti pakopomis ekvivalentas; perjungti
automatin# lang# išklojim# pakopomis.

Ctrl+Alt+M Langas → Išd#stymo veiksena → Rankin# veiksena
ekvivalentas; perjungti rankin# lang# išd#stym#.

Ctrl+Alt+T Langas → Išd#stymo veiksena → Kortel#mis
ekvivalentas; tvarko langus viršuje rodom# korteli#
d#ka.
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Spartieji klavišai Aprašas

Ctrl+Alt+S Window → Save as new session  equivalent; saves
current layout as new session.

Ctrl+Alt+W Langas → Užverti visus langus  ekvivalentas;
užveria visus atvertus langus.

Ctrl+A Pažym#ti visk#. Tai pažymi vis# tekst# skaitymo
languose.

Ctrl+C Kopijuoti. Tai nukopijuoja pažym#t# tekst# #
iškarpin#.

Ctrl+F Paieška. Tai leidžia jums atlikti paiešk# skaitymo
lango viduje.

Ctrl+G Langas → Iškloti vertikaliai  ekvivalentas.

Ctrl+H Langas → Iškloti horizontaliai  ekvivalentas.

Ctrl+I Langas → Iškloti  langus ekvivalentas.

Ctrl+J Langas → Išd#styti pakopomis  ekvivalentas.

Ctrl+L Keisti viet#. Kei#ia d#mesio centr# # pasirinktos
veiklos #ranki# juostos lauk#.

Ctrl+N Atlikti paiešk# šio lango veiklose.

Ctrl+O Search → Search in open work(s)  equivalent; opens
the search dialog to search in all currently opened
works.

Ctrl+Q File → Quit  equivalent; closes BibleTime.

Ctrl+W Užveria esam# lang#.

F1 Pagalba → Žinynas ekvivalentas; atveria žinyn#.

F2 Pagalba → Biblijos studijavimo instrukcija
ekvivalentas; atveria Biblijos studijavimo
instrukcij#.

F3 Pagalba → Dienos patarimas... Atveria nauding#,
naudojimosi programa BibleTime, patarim#.

F4 Nustatymai → Knyg# lentynos tvarkytuv#
ekvivalentas; atveria Knyg# lentynos tvarkytuv#.

F8 Rodinys → Rodyti knyg# lentyn#  ekvivalentas;
perjungia knyg# lentynos rodym#.

F9 Rodinys → Rodyti perži#ros langel#  ekvivalentas;
perjungia perži#ros langelio rodym#.

Shift+Down View → Auto scroll down

Shift+Up View → Auto scroll up

Space View → Auto scroll pause

20


